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1 Document Overview 

Purpose 

This document provides user guidance on how to use the LMEselect GUI. 

Intended Audience 

This document is aimed at anybody – whether they are acting in a trading or non-trading capacity – 

intending to use the LMEselect GUI.  

 

Any questions or queries should be directed to Trading Operations at tradingoperations@lme.com or 

0207 113 8200. 

Related Documents 

Pre-Trade Risk (PTRM) User Guide (https://www.lme.com/en-GB/Trading/Systems/LMEselect) 

LMEselect New User Form (https://www.lme.com/en-GB/Trading/Systems/LMEselect) 
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2 Introduction 

LMEselect is the electronic trading platform of the London Metal Exchange. The system allows trading 

users to change, cancel, activate and inactivate orders in metal futures, carries, strips, averages, 

options and TAPO’s traded on the LME. Non-trading users of members have read-only access to all 

functions of LMEselect. 

 

Users – whether acting in a trading or non-trading capacity - can only access LMEselect if they have 

been authorised by their firm’s compliance department. Users will have unique logon credentials 

supplied to them by the LME Trading Operations team. 

 

LMEselect trades are anonymous in all windows but details can be seen in LME Clear, however. To 

track trades executed on LMEselect, users can find the clearing number displayed in the Trade History 

window to check details in LMEsmart or the LME Clear application, LMEmercury. 

 

Owing to the highly customisable nature of the LMEselect GUI, it is worth noting that users can 

reset their perspective to the default setting by clicking the Window toolbar menu, followed by 

Reset Perspective; OR clicking the Window tool bar, selecting Open Perspective and then 

choosing the default Trading perspective. 
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3 LMEselect Member User Types 

The user types offered to the Members fall into two main categories, being front office trading staff and 

back office/middle office users. All new account requests must be submitted to the Trading Operations 

Team (TradingOperations@lme.com) by dedicated authorised personnel, known to the LME. The 

LMEselect New User form must be completed in full and the account will not be created until Trading 

Operations are satisfied with all the details provided. 

 

Front-office trading staff have several different types of trading accounts open to them and each has 

its own characteristics and privileges. With the use of Member ‘Business Units’ it is possible to 

segregate Trader’s visibility and control of orders from one another, by creating separate ‘Business 

Units’ Traders from one unit are unable to view or manage orders to that of traders in another unit. 

Those with view (Back Office) accounts placed within a ‘Business Unit’ are also restricted to visibility 

of accounts within the unit. 

 

There is however a view account that exists above the Member’s ‘Business units’ and has visibility of 

all accounts within a Member firm. This is known as a ‘Back Office (Super View)’ account. 

 

The LME provides and supports a GUI client that is available to the Member users only. For Member 

clients who order route, they will access LMEselect through the use of a third party application and 

connect via the FIX API.  

 

There are three User types of FIX accounts, the following FIX User types that are provided to Members 

can also be segregated by ‘Business Units’: FIX Trader and FIX Drop Copy, as these accounts provide 

specific order and trade data. However the remaining FIX type: FIX Market Data provides anonymous 

bids, offers and trades and therefore exists above all units. 

 

3.1 Account Types 

GUI Trader 

A GUI Trader has the privileges to execute orders and trades by using the LMEselect GUI client. They 

have visibility and control of only their own activity within the LMEselect trading system. They may also 

request order & trade history reports. Short Code within the New User form: ‘T’. 

GUI VIP Trader 

A GUI VIP Trader has all of the privileges of a GUI Trader with the additional visibility of all orders and 

trades executed by other GUI Traders within their own ‘Business Unit’, plus the visibility of orders and 

trades executed by FIX users also within the ‘Business Unit’. Short Code within the New User form: 

‘V’. 

 

Back Office ‘View’ 

A Back Office account provides users with a ‘view only’ type of access on the LMEselect trading client. 

The users will have no trading rights associated with this account type and it is generally used for 

monitoring the market and provides reconciliation purposes. This account type has visibility of all orders 

mailto:TradingOperations@lme.com
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and trades executed by both FIX and GUI users within the ‘Business Unit’. They may also request 

order & trade history reports. Short Code within the New User form: ‘B’. 

 

Back Office ‘Super View’ 

A Super View account exists above all ‘Business Units’, providing the Super View user with visibility of 

all orders and trades carried out by FIX and GUI users, across all units. Moreover this account type 

provides full market visibility (the same as a Back Office account) for monitoring purposes. Short Code 

within the New User form: ‘S’. 

 

VIP Supervisor 

A VIP Supervisor account exists above all ‘Business Units’, providing the user with visibility of all orders 

and trades carried out by FIX and GUI users, across all units. In addition, this account can inactivate 

or cancel any active orders in LMEselect placed by any FIX or GUI account. This account type has all 

of the privileges of a ‘Super View’ user. Short Code within the New User form: ‘VS’. 

 

PTRM Manager 

A PTRM Manager account has the same visibility of the Market as a ‘Super View’ user; in addition to 

the Market visibility this account has access to the PTRM system within LMEselect. This access type 

can view all Pre-Trade Risk reference data related to themselves and entities that belong to them, with 

the privileges to also edit all PTRM reference data. Short Code within the New User form: ‘PM’. 

 

PTRM Manager ‘View’ 

A PTRM Manager ‘View’ account has read-only access to the PTRM system and all related PTRM 

reference data. This account cannot edit any PTRM reference data. Short Code within the New User 

form: ‘PMR’. 

 

FIX Trader 

A FIX Trader account uses a third party ISV application to connect to the LMEselect API which 

facilitates order placement and trading. This account is placed within a ‘Business Unit’ but only has 

visibility and control of its own orders and trades. Short Code within the New User form: ‘FT’. 

 

FIX Market Data 

A FIX Market Data account subscribes to a live real time anonymous data feed from the LMEselect 

system. This account type has no trading privileges and is used to give a real time picture of the 

LMEselect market and updates. Short Code within the New User form: ‘FM’. 

 

FIX Drop Copy 

A FIX Drop Copy account subscribes to a real time data feed from the LMEselect system which 

contains all order and trades associated with the individual Member and its users. This account type 
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may request order and trade history reports across all ‘Business Units’ and is used for reconciliation 

purposes. Short Code within the New User form: ‘DC’. 

 

FIX Drop Copy (Unit Specific) 

A FIX Drop Copy Unit Specific account subscribes to a real time data feed from the LMEselect system 

which contains all orders and trades associated with the individual Member within the specified 

‘Business Unit’. This account type may request order and trade history reports from its own unit and is 

used for reconciliation purposes. Short Code within the New User form: ‘DCU’. 

 

CTS FIX PTRM Manager 

A FIX PTRM Manager account uses a third party ISV application to connect to the LMEselect PTRM 

API. This account can view all PTRM reference data related to themselves and entities that belong to 

them, as well as the ability to edit the Member’s PTRM reference data. Short Code within the New 

User form: ‘FPM’. 

 

CTS FIX PTRM Manager ‘View’ 

A FIX PTRM Manager View account uses a third party ISV application to connect to the LMEselect 

PTRM API. This account can view all PTRM reference data related to themselves and entities that 

belong to them but cannot edit the Member’s PTRM reference data. Short Code within the New User 

form: ‘FMR’. 
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4 Starting & Exiting LMEselect 

4.1 Login 

 

Figure 1 – Login Screen 

 

The Login Screen is the user’s entry point to the LMEselect Trading Client. All users are assigned a 

unique User ID that is tied to a password. The Login Screen contains fields for user name and 

password. To exit the Login Screen, the user must click Esc on the keyboard. 

 

Users can choose their own password, which must be between 8-20 characters and include at least 

one number. The system requires users to change their password every 30 days. If the password is 

entered incorrectly, users will get a further two chances to enter the correct password before being 

locked out. Trading Operations must be e-mailed to reset the password (tradingoperations@lme.com), 

which will expire automatically on Login. Users will then be prompted to change the password before 

proceeding further. 

Please note that symbols cannot be used as part of the password. 
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4.2 Quick-Locking 

It is possible to instantly lock LMEselect to prevent unauthorised access. Additionally, after a certain 

time period has elapsed with no activity on LMEselect, the system will lock itself to prevent 

unauthorised access. The lock setting can be changed as is described below. No trading activity is 

visible when the screen lock is on. To unlock the screen, the user must re-enter their password. 

 

Figure 2 – Screen Lock 

 

To quick-lock the LMEselect screen, the user must click on the File menu and then click Lock 

Application. 

 

Figure 3 – Initiating Quick-Lock  

 

To change the lock settings, the user must click on the Window menu and then click Preferences 

where a dialog box will appear. In the tree to the left, click Lock and Shutdown. In Lockout time, the 

user must enter a time in minutes and then click OK. A maximum value of 1440 minutes can be entered 

as a value. 
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Figure 4 – Lockout Interval 

4.3 Changing Password 

Changing the Password 

1. On the File menu, click Change Password. 

2. Type the current password. 

3. Type the new password and then confirm it. 

4. Click OK. 

4.4 Exiting LMEselect 

There are several ways to exit LMEselect: 

1. In the main window, click  in the upper-right corner. 

2. On the File menu, click Exit. 

3. Press [ALT] + [F4]. 

 

4.5 Disconnects & Trade halt 

If a trade halt is initiated or a user is disconnected then all orders (including GTC orders) will be 

inactivated. Upon reconnection, if the user does not reactivate their orders then they will be purged 

from the system at 19:00 for Base and 20:00 for Precious. If the user does reactivate their orders 

however, then they will continue to be worked as normal.  
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4.6 ‘Kill’ Functionality 

The emergency ‘Kill’ functionality enables the deletion of all orders at a user, unit or member level. 

There are several ways to apply kill functionality: 

 

Member Control 

 Preventing new orders being placed – PTRM managers can move users to the ‘unassigned’ 

account to stop any new orders being placed in the order book by a specific user 

 Removing orders from the order book – VIP Supervisors or VIP Traders (within the same 

member unit) can inactivate live orders to remove them from the order book 

LME Control 

  Disabling Access – The LME can disable access at a user, member unit or member level. This 

will both inactivate live orders and prevent new orders from entering the order book. A 

members Compliance department must contact the Trading Operations team to request this.    

 

5 Navigating LMEselect 

5.1 LMEselect Interface 

The screenshot below in Figure 5 shows the Overview perspective as it appears when LMEselect is 

opened. 
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Figure 5 – Overview Perspective 

5.1.1 Perspectives 

LMEselect contains a set of functions, each of which is represented by a perspective. 

A perspective provides a set of functionality aimed at accomplishing a specific type of task. The 

Trading perspective, for example, provides all trading functionality in LMEselect, whilst the PTRM 

perspective provides all the PTRM-related functionality. 

A perspective contains views, such as the Orderbook view in the Trading perspective. 

5.1.2 Views 

Users can change the layout of a perspective by opening, closing, detaching and docking views. 

Views have their own menus. Some views also have their own toolbars. The actions represented by 

buttons on toolbars only affect the items within that view. 

A view might appear by itself, or stacked with other views like a tabbed notebook. 

Figure 6 below shows where view options exist. 
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Figure 6 – Views 

 

To open a menu for a view 

Click  to the right of the view’s name. 

To minimise a view 

Click  to the right of the view’s name. 

To maximise a view 

Click  to the right of the view’s name. 

To restore a view 

Click  to the right of the view’s name. 

5.1.3 Toolbar 

The main window contains a toolbar with buttons that give you quick access to various commands. In 

the View menu users can change settings for the toolbar. 

 

Figure 7 – Toolbar 
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To show or hide the toolbar 

On the View menu, select or de-select Show Toolbar. 

To customise the toolbar 

 

1. On the View menu, click Customise Toolbar.  

2. Select toolbar buttons and move them between the Available toolbar buttons column and the 

Current toolbar buttons column with the arrows. 

3. Click OK to apply the changes. 

 

 

Figure 8 – Customising the toolbar 

5.1.4 Perspective Bar 

In the perspective bar, the names of open perspectives are displayed. The name of the perspective 

that is currently active is highlighted. 

 

Figure 9 – Perspective Bar 

5.1.5 Title Bar 

At the top of the interface is the title bar. It shows information about the application, user and IP address. 
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Figure 10 – Title Bar 

5.1.6 Symbols & Buttons 

This section explains the symbols and buttons in LMEselect. 
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5.2 Menus 

At the top of the window is a menu bar with a number of menus. 

 

 

5.2.1 File Menu 

The File menu contains commands for saving changes, changing password and exiting LMEselect. 

Command Description 

Export Excel Opens a menu containing the commands Export All to Excel 

and Export Selected to Excel. When the user chooses one or 

the other, a dialog box appears that permits the Excel file to be 

saved. 

Change Password Opens the Change Password dialog box where the user can 

change the password. 

Lock Application Quickly locks LMEselect. The user can unlock it with their 

normal login password. 
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Exit Exits LMEselect. 

 

5.2.2 View Menu 

The View menu contains commands for changing the toolbar. 

Command Description 

Hide/Show Toolbar Hides or displays the toolbar in LMEselect. 

Customise Toolbar Opens the Customise Toolbar dialog box where you can select 

which toolbar buttons you want to display. 

 

 

5.2.3 Trading Menu 

The Trading menu contains commands for trading operations. 

Command Description 

Enter Carry Order Opens a dialog box where you can enter a carry order. 

Enter Outright Order Opens a dialog box where you can enter an outright order. 

Enter Option Order Opens a dialog box where you can enter an option order 

 

5.2.4 Orders/Trading Menu 

The Orders/Trading menu contains commands for opening views in LMEselect. 

Command Description 

Orderbook Opens the Orderbook view. 

Order History Opens the Order History view. 

Trade Ticker Opens the Trade Ticker view. 

Trade History Opens the Trade History view. 

Trade Statistics Opens the Trade Statistics view. 
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Market Messages Opens the Market Messages view. 

Market Statistics Opens the Market Statistics view. 

 

5.2.5 User Profile Menu 

The User Profile menu contains a command for opening the User Settings dialog box. 

Command Description 

User Settings Opens the User Settings dialog box. (See User Settings on 

page 27). 

 

5.2.6 Watch List Menu 

The Watch List menu contains commands for creating and opening watch lists. 

Command Description 

Open Opens a sub-menu containing the names of the open watch 

lists. Select a watch list to display it in view. 

Create New Opens a dialog box where you can create a new watch list. 

Modify Watch List Opens a dialog box where you can rename or delete a watch 

list. 

 

 

5.2.7 Prices Menu 

The Prices menu contains commands for opening views that display VWAP-calculated prices for 

markets being BCP or VWAP-enabled. 

Command Description 

BCP Official Prices – View Opens a view displaying VWAP-calculated BCP prices for a 

selected market. The selected market is BCP-enabled and has 

its own BCP view. This view contains information about 3M and 

Cash contracts. 
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VWAP View Opens a view displaying VWAP-calculated prices for markets 

that are VWAP-enabled. This view contains information about 

3M contracts. 

 

5.2.8 Window Menu 

The Window menu contains commands for opening new windows of LMEselect, showing views and 

the inbox for displaying messages, managing perspectives and setting preferences. 

Command Description 

Show Inbox Opens the Inbox view. 

Show 3M Opens a sub-menu containing 3M contracts. Select a contract 

to display it in view. 

Open Perspective  

Save Perspective As Opens a dialog box where you can set a name of the 

perspective. 

Modify Perspectives Allows you to change current perspectives 

Reset Perspective Resets the perspective to the default settings. 

Close Perspective Closes the active perspective. 

Close All Perspectives Closes all perspectives. 

Preferences Opens the Preferences dialog box. 

 

5.2.9 Help Menu 

The Help menu contains commands for showing help, information about LMEselect and showing error 

messages. 

Command Description 

Display Help Opens the online help. 

About Displays the name and version number of LMEselect. 
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Show Message Tracker Displays the message logs of the current connection 

Show Log Opens the Error Log view. 

 

6 Customisation 

There are several ways the user can customise the appearance and contents of LMEselect. 

6.1 Perspectives & Views 

Users can customise perspectives to suit their style of working. 

6.1.1 Opening Perspectives 

When the user starts LMEselect for the first time, the Trading perspective is automatically opened. 

However, when the user starts LMEselect the subsequent time, the perspective that was displayed 

when the program was exited appears. 

To open a perspective the user needs to do EITHER of the following: 

1. Click Window and point to Open Perspective. Select the perspective name. 

2. Click  and select the perspective name in the dialog box that appears. Click OK. 

6.1.2 Customising Perspectives 

To show only the perspective icon 

1. Right-click anywhere on the perspective bar. 

2. In the shortcut menu that appears, click the checked Show Text option. 

 

Figure 11 – Show text on perspective icon 

 

To move a view 

Views can be moved around. Users must drag and drop the tab of a view to the desired position, which 

can be seen below in Figure 12 and Figure 13. 
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Figures 12 & 13 – Moving a view 

 

To close a view 

1. Right-click a view name. 

2. Click Close. 

6.1.3 Creating Own Perspectives 

Instead of reconfiguring a perspective, users can create their own. The user can customise the 

perspective so that it contains all of the views they use the most frequently. Once the user has created 

the perspective, they will need to save it under a name of their choice. 

To create a personal perspective 

1. Add views of choice. 

2. Move views to new positions within the perspective by dragging and dropping. 

3. Close undesirable views. 

4. Save the perspective (click Window and go to Save Perspective As). 

6.1.4 Saving Perspectives 

Users can customise a perspective and save it to a new name. 

To save a perspective 

1. The user can customise or amend the perspective accordingly. 

2. On the Window menu, click Save Perspective As. 

6.1.5 Resetting Perspectives 

If a perspective has been amended, the user can reset the perspective so that it returns to its last saved 

appearance. 

To reset an perspective 

1. On the Window menu, click Reset Perspective. A dialog box appears. 
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2. The user must confirm they want to reset the perspective by clicking OK. 

6.1.6 Closing Perspectives 

The user can close a perspective one at a time or all at once. There are two ways to close one 

perspective at a time. 

Note: When the user exits LMEselect, the current perspective automatically saves. The next time the 

user opens LMEselect it will appear exactly as it was when it was last closed. 

To close a perspective 

1. The user must choose the perspective to be closed. 

2. On the Window menu, click Close Perspective. 

OR 

1. Right-click the perspective’s name in the perspectives bar. 

2. Click Close. 

To close all perspectives 

On the Window menu, click Close All Perspectives. 

 

6.2 Tables 

Many views contain information in tabular format. Users can select which columns they wish to be 

displayed in a table and sort and copy the contents. 

6.2.1 Displaying & Hiding Columns 

In several perspectives and views, the user can decide which table columns they wish to display. In 

some perspectives, the user can choose which rows to display using the same option. 

To display and hide columns 

1. Click  in the upper-right corner of the tab. A shortcut menu appears. 

2. Click Choose Columns. A dialog box appears. 

3. The user can then do any of the following: 

 

- To remove a column from the table, click the column’s name in the Display Columns list and click 

Remove. 

- To add a column to the table, click the column’s name in the Available Columns list and click Add. 

- (If the Available Columns list is empty, there are no columns to add). 

- Click OK. 

6.2.2 Moving Columns 

In several perspectives and views, the user can move table columns. There are two ways to do it. 

To move columns directly in the table 

- Drag the column to the relevant area. 
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To move columns using the Choose dialog box 

 

1. Click  in the upper-right corner of the view. A shortcut menu appears. 

2. Click Choose Columns. A dialog box appears. 

 

Figure 14 – Moving Columns 

 

3. Click a column’s name in the Display Columns list. 

4. Do either of the following: 

- To move the column to the left in the table, click Up. 

- To move the column to the right in the table, click Down. 

5. Click OK. 

6.2.3 Sorting Columns 

In almost all tables the column contents can be sorted. 

Note: In the Message Tracker perspective, the table cannot be sorted. 

To sort column contents 

- Alphabetical order – click a column heading so that the  symbol becomes visible to the right of the 

heading. 

- Reverse alphabetical order – click a column heading so that the  symbol becomes visible to the 

right of the heading. 

- The order its contents were entered – click the column heading so that neither symbol is visible. 
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6.2.4 Optimising Column Widths 

To make reading the tables easier on the eyes, users can automatically optimise all column widths to 

fit the contents. 

To optimise column widths 

1. Click  in the upper-right corner of the view. A menu appears. 

2. Click Optimise Column Widths 

6.2.5 Exporting Data to Excel 

You can export either selected data or all data from tables to Excel. 

To export selected data 

1. Select a row in a table. 

2. Open the File menu or click  to the right of the view name. 

A dialog box appears that allows the user to save the Excel file. 

6.2.6 Copying Data from Tables 

In tables with configurable columns (columns that can be visible or hidden), the contents of the visible 

columns can be copied. 

To paste the copied contents into, for example, an Excel spread sheet or an e-mail; use the ordinary 

paste function (pressing [CTRL] + [V]). 

To copy a table 

1. Click  to the right of the tab name. 

2. Click Copy > All. 

To copy rows of a table 

1. Select a row in a table. 

2. Click  to the right of the tab name. 

3. Click Copy > Selected. 

6.2.7 Changing Fonts & Table Colours 

In some table views, users can change the font and background colour. 

To change the font and table colour 

1. Click  in the upper-right corner of the tab. A shortcut menu appears. 

2. Click Properties. A dialog box appears. 

3. Do any of the following: 

- To set the background colour of the table, click the colour button next to Background Colour and 

select a new colour in the dialog box. 

- To set the foreground colour (the font colour), click colour button next to Foreground Colour and 

select a new colour in the dialog box. 
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- To change the font colour and the font’s appearance, click Change and set the desired look for the 

font in the dialog box that appears. 

4. Click OK. 

6.2.8 Real-Time Excel Feed 

You can export real-time information feed from a watch list to Excel. All information the user places in 

the watch list automatically appears in the Excel sheet. 

The user can view information for only one watch list at a time. 

To feed watch list information to Excel 

1. Click  in the upper-right corner of the tab in the watch list. A shortcut menu appears. 

2. Click Feed to Excel. An Excel sheet opens. 

6.2.9 Working with different computers 

Users can export data from one environment to another environment (i.e. one computer to another). 

Data can be exported by copying a saved perspective to a memory device ad importing it to another 

LMEselect installation. 

Note: To perform this action, users must have the same access on all workspaces. 

To move workspaces 

1. Customise the perspective that you user wishes to be saved. 

2. On the Window menu, click Save Perspective. 

3. Close LMEselect. 

4. Open the folder where LMEselect was installed. 

5. Open the Workspaces folder. 

6. Save the user folder to a portable memory device, such as a USB drive. 

7. In the other computer, save the content in the corresponding Workspaces folder. 

6.3 User Settings 

The User Settings dialog box provides a way to view and change general application settings related 

to the desktop appearance and behaviour, as well as various user properties. Any changed values will 

take effect immediately. 

To open the User Settings dialog box 

- On the User Profile menu, click User Settings. The User Settings dialog box appears. It contains 

three tabs: 

 

Figure 15 – User Settings 
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6.3.1 Confirmations Tab 

In the Confirmations tab, users can adjust settings for Order Confirmations and Trade Popups. 

From here, users select pop-up confirmations for order management and trade management. 

To save changes, click Apply. 

6.3.2 Order Entry Tab 

In the Order Entry tab, users can set their own soft limits for price deviation and quantity; this is done 

to reduce the risk of errors. If the soft limits are exceeded, the system displays a warning but the order 

can still be entered. 

A default quantity can be set for an order. This value is displayed when the user opens the Enter Order 

dialog box. 

To change a limit or quantity 

1. The user must click in the column that they want to change limits or the quantity for. It can be any of 

the following: 

- Max Price Deviation 

- Max Quantity 

- Default Quantity 

2. Enter the value. 

3. Click Apply to save changes. 

Note: Limits set by the LME cannot be overridden. 

6.3.3 Export Files Tab 

In the Export Files tab, you can set the target of data exported to Excel spread sheets. 

- To save changes, click Apply. 
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7 Views in LMEselect 

LMEselect contains a set of views and all perspectives display various view by default. Users can 

adjust the size of views by dragging the split bars. 

The views below are described in alphabetical order. 

7.1 Inbox 

Market messages generated during the current business day are displayed immediately after they are 

sent. They are visible in the Market Messages view and in the Market Messages sub-view in the 

Inbox view. Messages are listed in time-priority order. 

To view a market message in the Inbox view 

- In the Inbox view, click the Market Messages tab. The Market Messages sub-view appears. The 

information in bold is the time the message was sent. The second row contains the market message. 

 

Figure 16 - Inbox 

7.2 Market Messages 

Market messages generated during the current business day are displayed immediately after they have 

been sent. They are visible in the Market Messages view and in the Market Messages sub-view in 

the Inbox view. They are listed in time-priority order. 

When a market message is sent out, users will receive a notice. 

To view a market message in the Market Messages view 

- On the Orders/Trading menu, click Market Messages. The view appears in the active perspective. 

Note: If a market message was sent before you log into LMEselect it is shown only in the Market 

Messages view, not in the Market Messages sub-view in the Inbox view. 
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7.3 Market Statistics 

This view displays the volume traded in LMEselect. Users must select a date in Time Period. The 

content must be refreshed to review the latest volume traded. After retrieval, the Market Statistics 

items can be filtered on Product. 

To view Market Statistics 

- On the Orders/Trading menu, click Market Statistics. 

 

Figure 17 – Market Statistics 

7.4 Markets 

This view displays all markets and users can create watch lists from this view. The Markets view shows 

the best bids and offers with aggregated quantity for the selected contracts.  

 

Figure 18 – Markets 
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7.5 Message Tracker 

The Message Tracker view shows all messages that have been sent to and from LMEselect. The 

messages are displayed in chronological order and are updated every time a message is sent or 

received. 

Note: The message tracker in LMEselect only shows the communication between LMEselect and the 

TAX server process that LMEselect is configured to connect to. 

7.6 Order History 

This view displays a log with all order actions of a user and a firm for a given time period. The view 

displays orders created intra-day and also for older orders too. The orders that are visible depend on 

your access rights and the current day is the default. Users can change the period and instruments 

and refresh the contents. The Order History view holds a maximum of 30 business days’ worth of 

data. 

 

Data can be exported to Excel. 

To view Order History 

- On the Orders/Trading menu, click Order History. 

 

Figure 19 – Order History 

 

Time and date search. 
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7.7 Orderbook 

The Orderbook view is displayed in the default Trading Perspective. Additionally, it can be opened by 

selecting Orderbook from the Orders/Trading menu. The Orderbook displays all orders for the trader 

of the firm. All active, inactive and partially-filled orders are displayed. Cancelled orders, however, are 

displayed in the Order History view. 

The  button inactivates all the orders of the trader who initiated the request. In essence, 

only his or her orders will be inactivated; any other orders that are being worked by other people in the 

firm will remain active. 

By right-clicking over an order, users can change an order, cancel an order, activate or inactivate an 

order, open the Order History of an order and open the Order Depth Ladder for the contract of that 

order.  Users can also activate an inactive order – or vice versa – by clicking the tick box in the Inactive 

column. 

Users can change the sort order by clicking on the top of any of the columns. For example, if the user 

wanted the orders to appear by price, then they can click on the Price column. 

 

Figure 20 – Orderbook 
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7.8 Order Depth Ladder 

The Order Depth Ladder view shows aggregated order levels and the view is updated in real time. To 

open the Order Depth Ladder, users must right click on a view and select the option. 

 

Figure 21 – Order Depth Ladder 

7.9 Trade History 

The Trade History view displays a log of all user or firm trades (depending on the account type) during 

a given time period. The current day is set to default upon opening the Trade History, although users 

can change the time and date period and subsequently refresh the contents. The Trade History view 

holds a maximum of 30 business days’ worth of data. 

Having searched within specific parameters, the historical content can be filtered on contract, contract 

group, trader, order number, trader number and buy/sell. 

Users can export the data to Excel. 

To view Trade History 

Users can do one of two things: 

1. Click the  icon at the top left of the screen. 

2. On the Orders/Trading menu, click Trade History. 

7.10 Trade Statistics  

The Trade Statistics view displays the volume traded by a firm during a select day. The Trade 

Statistics view holds a maximum of five business days’ worth of data. Users can change the time 

period and refresh the displayed contents. 
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To view the data, select a date and refresh the content. Users can export the data to Excel. 

To view Trade Statistics 

- On the Orders/Trading menu, click Trade Statistics. 

7.11 Trade Ticker 

Users can view all trades that have taken place in the whole market or alternatively, view their own 

trades. The filtering functionality allows users to search by Product (underlying), Contract and User. 

Trades involving the user and their firm will stay bold for a number of seconds. These trades are colour 

coded; blue indicates a Buy and red indicates a Sell. 

Viewing clips of trades 

Users can view clips of trades in the Trade Ticker view. Users can see a summarised calculation of 

the value weighted average price (VWAP) and the total number of gross lots for selected trades. 

1. In the Trade Ticker view, highlight and right-click on multiple contracts. 

2. Click Show Trade Clips. A dialog box appears 
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8 Orders 

* Pursuant to Decision Notice 20 283, with effect from 25 January 2021, users are Prohibited 

from entering any native discretionary orders in relation to all LME Contracts, or native 

iceberg orders in relation to Cash Settled Future and LMEmini Contracts. Please refer to the 

Decision Notice for the full scope. 

 

The order types remain active in the GUI, so the LME expects Members to implement 
appropriate controls to facilitate compliance with the Prohibition. Failure to comply with the 
Prohibition or failure to implement appropriate controls may result in a Member being subject 
to an investigation and disciplinary action by the LME.  
 

8.1 Enter Order Dialog Box 

To enter an order, the user must open an Enter Order dialog box. 

There are several ways of doing this, but the two most simplistic methods are: 

1. Click the  icon at the top left of the screen. 

2. On the Trading menu, click any of Enter Outright Order, Enter Carry Order, Enter Option Order. 
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Figure 26 – Enter Order 

 

The user then has six options at the top of the Enter Order dialog box; Outright, Carry, Option, 

TAPO, TAS Outright, TAS Carry. 

 

 

Outright Order – enter, cancel or update single and average outright orders. 

Carry Order – enter, cancel or update carry and carry average orders. In the dialog box, the user must 

enter a price and select one of the following buttons: 
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Option Order – enter, cancel or update option orders. 

TAPO Order – enter, cancel or update TAPO. 

TAS Outright – enter, cancel or update TAS 

TAS Carry – enter, cancel or update TAS (Currently disabled) 

Once the user has selected one of these six options, they will have to complete the remaining details 

such as Product, Prompt Date, Price etc. Once all the details have been completed the user can click 

on Buy/Borrow or Sell/Lend to place the order. 

8.1.1 Viewing Calendar & Selecting Prompt Date 

The prompt calendar displays the current month and the coming three-month period. Subsequent 

months and years can be selected in the column on the far right with the drop-down options. Only 

months with available prompt dates are displayed. Non-tradable days, expired dates and dates that 

are non-valid prompts for a particular commodity are greyed out in the calendar.  

Depending on the selected underlying and contract group, the prompt calendar displays available 

prompt dates. 

To view prompt calendar 

- In the Order dialog box, click  to open the Calendar. 

To select prompt date 

1. Open the Calendar. 

2. The user selects the date they want to be the prompt date by clicking on it. 

Note: When a prompt date has been selected, the prompt date calendar is closed and the date is 

displayed in the contract field in the Enter Order dialog box. 

 

Understanding colour codes in the calendar 

Colours indicate the different dates: 
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8.2 Incremental Buttons 

 

On the Enter Order window, the incremental buttons allow a user to increase or decrease values by 

clicking on the relevant icon. The incremental buttons are available for the Price, Quantity, Iceberg, 

Discretionary and Scaling options. 

 

 

8.3 Order Types 

 

8.3.1 Iceberg 

* As of 25 January 2021, Members are prohibited from entering native iceberg orders on Cash-

Settled Futures and LMEmini Contracts. However, the use of synthetic iceberg orders is still 

allowed. Please refer to Decision Notice 20/283 for details. 

 

An Iceberg is an order type where only part of the order quantity is displayed as public order 

information. This minimises the price impact of orders with very large quantities. By hiding the major 

part of the quantity, an iceberg reduces the risk of price movement caused by other traders seeing the 

intention to buy or sell a substantial quantity. An iceberg order has three quantity parameters: 

- Order quantity 

- Open quantity 

- Public quantity 

 

 

Figure 22 – Iceberg Order 

8.3.2 Discretionary Order 

* As of 25 January 2021, Members are prohibited from entering native discretionary orders on 

all LME Contracts. However, the use of synthetic orders is still allowed. Please refer to Decision 

Notice 20/283 for details. 
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8.3.3 Stop Order 

This is effectively a Stop-Limit order which utilises a ‘trigger price’ to activate it in the order book. A 

Stop-Loss order rests in the system and is not valid for trading until the trigger price condition is met. 

A buy order is triggered when the last traded price is equal to or higher than the trigger price, whilst a 

sell order is triggered when the last traded price is equal to or less than the trigger price. A Stop-Loss 

order is only visible on the private order flow. 

 

* A Stop-Loss order, when triggered, will place a standard limit order (with or without GTC validity) at 

the price specified at the time of order placement. Currently the maximum deviation between the order 

trigger price and limit price is hard coded at 2% of the trigger price. When a Stop-Loss order is triggered 

the resulting limit order is price validated against the current Dynamic Price Bands settings which may 

result in an order being rejected if the Dynamic Price Bands have been modified by the Exchange. 

 

In the example in Figure 24, the user is about to enter a sell stop for Aluminium 3M outright. The market 

price on Aluminium is currently trading at $1630; therefore when the market price falls to $1628 (the 

trigger price), the stop order will be activated. In the Price field – this value acts as a limit; therefore 

the system will not allow the stop to sell below the price of $1622. As the Price field acts a limit with a 

stop-loss order, the Price must be higher than the Trigger on a buy stop and the Price must be lower 

than the Trigger on a sell stop.  
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Figure 24 – Stop Order 

8.3.4 Scaling Order 

A Scaling order allows the user to enter multiple orders to enter the market at increments defined by 

the user. The user is able to enter a total of ten orders. The price entered in the Price field will be the 

order first worked.  

To enter a Scaling order 

1. Tick the Scaling tick box. 

2. Enter the Incremental value. 

3. Select the number of orders in the Orders section. 
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Figure 25 – Scaling Order 

 

8.4 Order Validities 

Each order has a validity which specifies the criteria of when and for how long the order is to be worked. 

This can be found in the Valid section. 

 

Day – The order will be worked for the current trading day. The order will be inactivated when a trader 

logs out of the system or at 7pm when trading activity ceases (8pm for LMEprecious products).  Any 

inactive orders will be cancelled at 7.30pm (8.30pm for LMEprecious products) when LMEselect closes. 

 

GTC – The order will be worked continuously, even if the user is not logged into LMEselect. Unless the 

order is inactivated, the order will be saved down at the end of each trading day and re-loaded every 
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morning for the Pre-Open phase. GTC orders are only available for Cash and 3M outright orders. It is 

also worth noting that GTC orders are only price validated on the day of entry; they are not 

subsequently price validated when re-loaded to the system on following days. 

 

Ring 1 – The order will be worked until 11.40am, which coincides with the opening of the Ring 1 trading 

session of the LME’s open-outcry market. If a user tries to enter a Ring 1 order after 11.40am then the 

order will be rejected. 

 

Fill And Kill – Orders with a validity of Fill And Kill cannot be found in the Valid section of the Enter 

Order window. Instead, users must go to a view with active orders (such as PBD 3M, for example). 

Using this order type, users can select the desired quantity they wish to trade and be given an average 

price for the trade. If they have selected a higher quantity than there is available in the market, the 

balance of the order will be killed. Note: The average price does not factor into account Iceberg or 

Discretionary orders, so the average price could potentially be better than what is stated. 

To place a Fill And Kill order, the user must double click on the bid or offer (depending on whether 

you wish to buy/borrow or sell/lend) that they wish to trade. For example, if the user wishes to lend 10 

lots of CADC-3M, they will double click on the bid. 

 

When the Execute Order window is launched, Order Type, Product, Prompt Date, Iceberg, 

Discretionary, Scaling, Stop Order and Valid will be greyed out. To trade, the user then adjusts the 

number of lots they wish to trade and can place the order thereafter. 

 

Inactive Orders – Any orders that are inactive when LMEselect closes at 7:30pm (8:30pm for LME 

Precious) will be purged from the system. 
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Figure 27 – Fill And Kill Order 

 

Date / Time – Users can also select a specific date or time to have the order worked to. The orders 

will work in exactly the same manner as a GTC order, the only difference being that they do have a 

specified end time. Date and Time orders are only available for Cash and 3M outrights. Note: The time 

selected is London time and NOT the user’s local time.  
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8.5 Enter Order Attributes 

Please note that new Legal Entity Identifiers (LEI) fields marked with an Asterisk are Mandatory and 

must be populated prior to execution. To confirm, LEI fields can be prepopulated by PTRM Managers 

for specific client accounts. 

 

Attribute Description 

Contract Contains Product and Prompt Date. The product is the 

underlying commodity of the order. The prompt date is the date 

for either single orders or multi-leg orders. 

Price The price of an order. 

Qty The quantity to buy or sell. The default value is 10. 

Open Quantity A numeric value specifying the open quantity of an Iceberg 

order. 

Cap Price The invisible price of a discretionary order. 

Incr The tick size between the generated orders, i.e. how much the 

price will differ from the base price. 

Orders The number of orders to be created. 

Iceberg A tick box specifying whether or not the order is an Iceberg 

order. 

Discretionary A tick box specifying whether or not the order is a stop-loss 

order. 

Stop Order A tick box specifying whether or not the order is a stop loss 

order. 

Scaling A tick box specifying whether or not the order is a scaling order. 

Users can simultaneously enter multiple orders. Users can enter 

the multiple orders at a standard increment scaled in a 

relationship to a basis price. 

Valid Date A field where the user specifies a business date for the order to 

expire. 
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Valid Time A field where the user specifies the time for the order to expire. 

Enter hh:mm:ss. The order will expire the current day. 

Valid 
Validation conditions can be any of the following: 

Day 

GTC 

Ring 1 

Fill And Kill 

Date 

Time 

Info A field where the users types a comment. This is anonymous to 

the rest of the market. 

Market Maker Identifier Option to provide the ID of the Market Marker placing the order 

 

8.6 Action Buttons 

Action Buttons Description 

Buy, Borrow 
Buy – outright and option orders 

Borrow – carry orders 

Once selected, the order is sent to market. 

Sell, Lend 
Sell – outright and option orders 

Lend – carry orders 

Once selected, the order is sent to market. 
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9 Watch Lists 

A Watch List contains a list of contracts. Watch lists are either pre-defined or they can be created and 

modified by the user according to their own preferences.  

 

Figure 28 – Watch Lists 

 

9.1 Creating Watch Lists 

Users can add contracts to a watch list in order to keep track of selected markets. The watch list is per 

user, which means that the user in question is the only one able to see their watch lists. 

To create a watch list 

1. On the Watch List menu, click Create New. A dialog box appears. 

2. Type the name of the watch list and click OK. The new, empty watch list now appears as a table in 

a view of its own in the active perspective. 

3. Type the name of a contract in Add Instrument and press [ENTER]. The contract now appears in 

the table. The user must repeat this step for all contracts they want in the watch list. 

Note: Users can modify a created watch list from the Watch List menu. From here, users can rename 

and delete watch lists. 

 

 

Pre-defined Watch Lists. 
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9.2 Automatically Created Watch Lists 

Pre-defined watch lists are available in the Watch List menu. Any time that a user creates an order or 

trade, the watch lists are instantly updated. 

To open a watch list 

- On the Watch List menu, point to Open and the user can select the watch list they wish to open. 

9.3 Viewing Order Depths 

The Order Depth Ladder shows the orders for each price level. 

To view the Order Depth Ladder 

1. Right-click a contract in a Watch List, in the 3M view, in the Orderbook or the Order History view. 

A shortcut menu appears. 

2. Click Order Depth Ladder. The depth ladder for the selected contract appears in the active 

perspective. 

See Figure 21 – Order Depth Ladder for more information. 

 

10 Columns & Field Descriptions 

Column or Field Description 

Account Ask Side The name of the ask side account. 

Account Bid Side The name of the bid side account. 

Acting User The acting user for the order action (e.g. the trader). 

Action 
The action performed on the reference data. This can be any of the 

following: 

Add 

Update 

Remove 

Add To Watch List 
Adds the selected trade(s) to the Watch List. 

Adds the selected contract to an ad-hoc created information group 

(shown as a “Watch List” in Compose Groups and in the instrument 

tree). 

Agg/Inst Aggressor or instigator information direction. 

Aggressor Indicates if the aggressor bought or sold. 



LMEselect 9.4 User Guide Version 1.3 

Classification: Public  

 

 
Page 48 

 

     
  

Ask Price The ask price. 

Ask Qty The ask volume. 

Bid The best bid for each marketplace. 

Bid Price The bid price. 

Bid Qty The bid volume. 

Borrow Sends a bid order request to the market. The window is closed after a 

successful order entry. 

Bought The total bought quantity. 

BQty The number of lots on the bid order. 

BQty (3M) Best bid with aggregated order quantity, expressed in number of 

contracts. 

Busted Trades deleted by the LME. 

Buy (Trade Ticker) Opens an Enter Order dialog box with the applicable trade data. 

Buy Member The ID of the member the buying user belongs to. 

Buy User The ID of the buying user. 

Buy/Sell Indicates whether the order is a buy or sell order. 

Buyer Firm The buyer firm ID (if you or your firm was involved in the trade). 

Buyer Trader The buyer trader ID of your trades (if you or your firm was involved in 

the trade). 

Carry The total traded quantity in the carry contract group. 

Clear (Enter Order) Clears the Client and Info drop-down list boxes and resets all controls to 

their default values. 

Clearing A clearing number. An option premium trade and a hedge trade has 

unique clearing number. If the trade is an internal cross, the clearing 
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number is replaced with Cross instead. Cross trades are not sent to 

clearing. 

Clearing Status The status of the trade at LCH. Options are set as Undefined. 

Client The client order ID reference. 

Client (text field) Enter the client account to filter on client account. 

Close (3M) The closing price from the previous trading day. 

Close (Messages) Closes the window and saves the messages created in the Client and 

Info drop-down lists. 

Comb Trade ID If the trade is part of a combination trade, this field contains the value of 

the Trade ID field of the combination trade that is the source of this trade. 

Contract Displays the contract ID. 

Counter Party Clearing 

Member 

The counterparty member responsible for clearing the order. 

Note: This field is only filled out if the current market transparency allows 

for it. 

Counter Party Member 
The ID of the counterparty member. 

Note: This field is only filled out if the current market transparency allows 

for it. 

Counter Party Owner Type 
The owner type of the counterparty side of the trade, 

It can be one of the following: 

CUSTOMER 

PRINCIPAL 

Note: This value is only visible if the currency market transparency 

allows for it. 

Counter Party Trading 

Member 

The ID of the counterparty participant’s sponsoring member. 

Note: This field I sonly filled out if the current market transparency allows 

for it. 

Counter Party User 
The ID of the counterparty user. 

Note: This field is only filled out if the current market transparency allows 

for it. 
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Date The date of the exception day. 

Date (Trade History) The trade entering date. 

Deal ID 
The ID of the deal this trade is part of. 

Note: A deal is defined as all trades generated by a single event. An 

event is, for example, an incoming order or an uncross. Thus all trades 

resulting from the same event will have the same deal number. 

Discretionary Price A discretionary order has two prices: a normal limit price and an 

improved cap price. The order displays the limit price but steps up to the 

discretionary price if there is an opportunity to trade at a better price. 

Export Exports the table content to an MS Excel file. 

From (Order History) The start date and time of the time period for Order History items. 

High Price The day’s highest registered price for the contract. 

Iceberg Open Qty (Enter 

Order) 

Tick and specify value if the user only wants part of the order to be 

invisible. An Iceberg order is where only a part of the order quantity is 

visible in public price information. 

Note: The Open Quantity value is subject to system restrictions. 

ID The ID assigned to each individual trade. It is unique both over time and 

within the system. 

ID (User) The ID of the user. 

Inactive Indicates if the order is inactivated. 

Info Any additional information. 

Info (check box) If selected, the dialog box expands to reveal more information. 

Last (3M) The price of the contract when it was last traded. 

Last Auction Price The last recorded auction price for the contract. 

Lend Sends an ask order request to the market. The window is closed after a 

successful order entry. 

Low (3M) Lowest traded price during the current day. 
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LQty The last traded quantity. 

Message The market message text. 

Metal The instrument name. 

Metal (Trade Ticker) Filters the display of orders. Only the selected instrument type is 

displayed in the table. 

Net The difference between total open long and open short positions held by 

a trader. 

Number of Trades The number of trades for a specific contract. 

Offer The offered price. 

Open First traded price today. 

Open Qty The open order volume (chunk size). 

Option The total traded quantity in the option contract group. 

OQty Best offer with aggregated order quantity, expressed in number of 

contracts. 

Order No The identity of the order. 

Order Qty The original order volume. 

Outright The total traded quantity in the outright contract group. 

Own Account Information about your own account. 

Own Ask Displays own ask order quantity. Can be used to place or update ask 

order. 

Own Bid Displays own bid order quantity. Can be used to place or update bid 

order. 

Own Clearing Member The member who is responsible for clearing the order. 

Own Info Text Information text for your own side of the trade. 

Own Member The ID of the member that the user belongs to. 
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Own Message Ref Message text about the trade. 

Own Offer The trader’s best offer on the contract. 

Own Private Order ID The own private order identifier. 

Own Trader ID The ID of the own trader. 

Own Trading Member The own participant’s sponsoring member. 

Own User The ID of the user. 

Premium and Underlying 

Price (Options only) 

Displays the calculated premium and prevailing underlying price (metal 

options only). 

Premium Price (Metal TAPO or 

Index Option) 

The premium which the user wishes to trade at. The price may be ticked 

up or down at the default tick size for the instrument and contract group 

by using the arrows or the numbered buttons. 

Previous Day Click the button to set the time period filter for the previous date’s trades. 

Price (Closing) The closing price of the contract. 

Price (Offering) The offering price. 

Price (Order) The price of the order. The highest priority property used for deciding 

the priority of the order. 

Price (Trade) The price of the trade. 

Product Use the filter to display the trade history of a particular instrument. 

Product (Enter Order) A drop-down list where the user selects a metal, plastic or the index 

(LMEX) instrument. 

Prompt Date (Enter Order) 
A drop-down list where the user can select a valid prompt date. Three 

prompt dates may be selected: 

3M 

TOM 

C 

If a different prompt date is desired, the list item Other opens a trading 

calendar where valid prompt dates may be selected. 
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Qty The number of trades. 

Receiving Member Counterparty member who receives a copy of the trade report half. 

Recipient (Market Message) The recipient of the market message. The cell is empty if the message 

is directed to all members. 

Reference Trade ID The reference trade ID is used to tie two trades together. It can be used 

to tie related trades together and to connect a busted trade with its 

replacement. 

Refresh Retireve a new list of trade statistics items. 

Remaining Qty (Enter Order) 
The remaining quantity of the order. 

Note: For Iceberg orders the open quantity is shown within parentheses. 

Scaling Incr and Orders Tick and specify values if the user wants to specify scaled orders. Scaled 

orders are a way to specify several orders with incremental prices. 

Sell (Trade Ticker) Opens an Enter Order dialog box with the applicable trade data. 

Sell Member The ID of the member that the selling user belongs to. 

Sell User The ID of the selling user. 

Seller Firm  The seller firm ID. 

Show Trader Columns Displays the trade ID for your own and your firm’s orders. 

Sold The total sold quantity. 

State The current trading state for the contract. 

Status (VWAP Prices view) The current status of the calculation. 

Sub Trade Type 
The subtypes of trade are: 

TRADE_REPORT – trade report execution 

TRANSPARENT_TO_TRANSPARENT_OWN_MATCH – execution of 

two transparent orders with own match. 

TRANSPARENT_TO_TRANSPARENT – execution of two transparent 

orders. 

TAPO The total traded quantity in the TAPO contract group. 



LMEselect 9.4 User Guide Version 1.3 

Classification: Public  

 

 
Page 54 

 

     
  

TASBASE The total traded quantity in the TASBASE contract group. 

TASPrecious The total traded quantity in the TASPrecious contract group. 

Time (Market Message) The time the market message was sent. 

Time of Trade The time for the trade to take place. 

Time of Event The time when the event took place. 

To (Order History) The end date and time period for Order History items. 

Today A button to set time period filter for today’s trades. 

Total The total number of trades traded during the current day. 

Total Turnover The total turnover for trades executed during the trading day. 

Trade ID Enter a trade ID to include in the search. 

Trade No The trade number. 

Trade No (Filtering result) Filter to only display items with certain trade numbers. If blank, view all 

items. 

Trade Price The price of the trade. 

Trade Type The type of trade. 

Traded Lots The quantity of the traded lots. 

Trader The ID of the trader that entered the trade. 

Trading Protection Limit 
Type of trading protection limit. The following values are allowed: 

NONE – The trading protection limit was not breached. 

TRADE_POSITION – The aggregated trade position limit was 

breached. 

TRADE_TURNOVER – The aggregated trade turnover limit was 

breached. 

Turnover The total turnover of the instrument. 

Underlying A reference to the underlying instrument. 
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Update Last Paid 
The following values are allowed: 

Yes – the trade is allowed to update 

No – the trade is not allowed to update 

Upper Price Limit The upper price limit. 

User (Trade Ticker) Filters the display of trades in the table. Can be set to own (only the 

logged in user) or firm. 

Val Last night’s evening evaluations. These prices will also incorporate the 

Cash and 3M date rolls. 

Valid Until (Order History) The order time constraint. 

Validity Time (Enter Order) A drop-down list for selecting and displaying order validity time. 

Value (Order) Last paid or higher. 

Volatility Price (Enter Order) The user enters the volatility at which they wish to trade. The volatility 

may be ticked up or down at the default tick size for the instrument and 

contract group by using the arrows or the numbered buttons. 

 

 

 

 

 

 


